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Introduction

Atmel Studio is the integrated development platform from Atmel®. It provides
a modern and powerful environment for doing AVR® and ARM development.

Get started by exploring the included example projects. Run your solution on
a starter or evaluation kit. Program and debug your project with the included
simulator, or use one of the powerful on-chip debugging and programming
tools from Atmel. Get productive with the various navigate, refactor and
intellisense features in the included editor.

With strong extension possibilities and online gallery, it is possible for both
designers and 3rd party to provide plug-ins and customize the environment
for best use and productivity.

Atmel Studio carries and integrates the GCC toolchain for both AVR and
ARM, Atmel Software Framework, AVR Assembler and Simulator. All newest
Atmel tools are supported including Power Debugger, Atmel-ICE,
Embedded Debugger, AVR ONE!, JTAGICE mkII, JTAGICE3, STK500,
STK600, QT600, AVRISP mkII, AVR Dragon™, and SAM-ICE™.
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1. New and Noteworthy
New features available.

1.1. Atmel Studio 7.0

Atmel Studio 7.0.943
Atmel Studio 7.0.943 contains a fix for the following bug:

• AVRSV-7459: Projects containing files with upper case file names can fail to build. Saving files with
upper case file names converts file name to lower case.

Atmel Studio 7.0.934
The following changes are done in Atmel Studio 7.0.934:

• AVR 8-bit GCC Toolchain 3.5.2 with upstream versions:
– gcc 4.9.2
– Binutils 2.26
– avr-libc 2.0.0
– gdb 7.8

• AVR 32-bit GCC Toolchain 3.4.3 with upstream versions:
– gcc 4.4.7
– Binutils 2.23.1
– Newlib 1.16.0

• ARM GCC Toolchain 4.9.3 with upstream versions:
– gcc (ARM/embedded-4_9-branch revision 224288)
– Binutils 2.24
– gdb 7.8.0.20150304-cvs

Atmel Studio 7.0.934 resolves the following issues present in Atmel Studio 7.0.790:
• AVRSV-7376: Atmel-ICE slow programming.
• AVRSV-7379: Unhandled exception when writing fuses or lockbits when Auto Read is turned off.
• AVRSV-7396: Some machines shows an error regarding 'Exception in MemoryPressureReliever'.
• AVRSV-7400: When in Standard mode, Disable debugWire and Close are not visible in the

Debug menu.
• AVRSV-7408: When using Atmel Studio in Standard mode, the Set Startup Project menu is

missing.

Atmel Studio 7.0.790
The following features are added in Atmel Studio 7.0.790:

• Support for mass storage mode in embedded debugger (EDBG), enabling drag and drop
programming

• Introduction of user interface profiles. The user can choose an interface where some of the toolbar
buttons and menu items are removed.

• Support for importing libraries to previously imported sketches. Added support for Arduino Zero and
Zero Pro.
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• Parallel build turned on by default

Atmel Studio 7.0.790 resolves the following issues present in Atmel Studio 7.0.634:
• AVRSV-7084: Persist user settings during upgrade.
• AVRSV-7014: Some ATmega and ATtiny devices failed to start debugging with the Simulator.
• AVRSV-7230: "Show all files" in Solution Explorer not consistent.
• AVRSV-7062: Firmware upgrade of Xplained Mini kits not detected.
• AVRSV-7164: Reading flash to .bin file created incorrect .bin file.
• AVRSV-7106: Hex files with unix or mixed file endings fail to load.
• AVRSV-7126: Databreakpoints for ARM should not be limited to RAM.

Atmel Studio 7.0.634
This release adds device support for the SAMB11 device family.

Atmel Studio 7.0.634 resolves the following issues present in Atmel Studio 7.0.594:

• AVRSV-6873: Jungo Driver issue with Windows 10.
Note:  If you install this version of Atmel Studio in parallel with an older Studio versions or IAR
Embedded Workbench and are using AVR Dragon, AVRISP mkII, JTAGICE mkII, AVR ONE!,
STK®600, or QT600 read How to downgrade to use older Jungo drivers.

• AVRSV-6676: Launching debugging fails due to issue with Intel graphics driver.

Atmel Studio 7.0.594
Atmel Studio 7.0.594 resolves the following issues present in Atmel Studio 7.0.582:

• AVRSV-7008: Opening a 6.2 project in Atmel studio 7.0.582 persists Debug configuration settings
for all the other configurations.

• AVRSV-6983: Uninstalling Studio extensions does not work in some cases.
• AVRSV-7018: Project Creation fails with some culture specific user names.
• AVRSV-7019: Help Viewer does not work on 32-bit machines.
• Issues with getting tools/debuggers recognized or visible see section 2.4 in ‘Atmel Studio 7.0.594-

readme.pdf’ for workarounds.

Atmel Studio 7.0.582
• Updated to Visual Studio Isolated Shell 2015
• Integration with Atmel Start.

– This tool will help you select and configure software components, drivers, middle-ware, and
example projects to tailor your embedded application in a usable and optimized manner

• New device support system, CMSIS Pack compliant
• Data Visualizer, used for processing and visualizing data
• Updated help system, improved context sensitive help
• Atmel Software Framework version 3.27.3. ASF is an extensive software library of software stacks

and examples.
• A major upgrade of the Visual Assist extension to Atmel Studio that assists with reading, writing, re-

factoring, navigating code fast
• Import Arduino Sketch projects into Atmel Studio
• Support for Flip-compatible bootloaders in atprogram and programming dialogue. The connected

device appears as a tool.
• AVR 8-bit GCC Toolchain 3.5.0 with upstream versions1:
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– gcc 4.9.2
– Binutils 2.25
– avr-libc 1.8.0svn
– gdb 7.8

• AVR 32-bit GCC Toolchain 3.4.3 with upstream versions1:
– gcc 4.4.7
– Binutils 2.23.1
– Newlib 1.16.0

• ARM GCC Toolchain 4.9.3 with upstream versions1:
– gcc 4.9 (revision 221220)
– Binutils 2.24
– gdb 7.8.0.20150304-cvs

1.2. Atmel Studio 6.2 Service Pack 2
• Atmel Software Framework 3.21.0
• Added support for the ATSAML21 device family
• Added support for the ATSAMV7 device family, based on the ATM Cortex-M7 core

1.3. Atmel Studio 6.2 Service Pack 1
• Atmel Software Framework 3.19.0
• AVR8 Toolchain 3.4.5 with upstream versions:

– GCC 4.8.1
– Binutils 2.41
– avr-libc 1.8.0svn
– gdb 7.8

• AVR32 Toolchain 3.4.2 with upstream versions:

– GCC 4.4.7
– Binutils 2.23.1

• ARM GCC Toolchain 4.8.4 with upstream versions:

– GCC 4.8.4
– Binutils 2.23.1
– gdb 7.8

• Support for trace buffers for ARM (MTB) and AVR32 UC3 (NanoTrace)
• Support for attaching to targets

1 For more information, see the readme that is installed as part of the toolchain.
2 For more information, see the readme that is installed as part of the toolchain.
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1.4. Atmel Studio 6.2
• Atmel Software Framework 3.17.0
• AVR 8-bit Toolchain 3.4.4 (with upstream GCC 4.8.1)
• AVR 32-bit Toolchain 3.4.2 (with upstream GCC 4.4.7)
• ARM GCC Toolchain 4.8.3
• Support for Atmel-ICE
• Support for Xplained Mini
• Support for data breakpoints
• Read OSCCAL calibration for tinyAVR® and megaAVR®

• Create ELF production files for AVR 8-bit using the programming dialogue
• Live Watch
• Non-intrusive trace support for SAM3 and SAM4 family of devices including

– Interrupt trace and monitoring
– Data trace
– FreeRTOS™ awareness
– Statistical code profiling

• Polled Data trace support for Cortex M0+
• Default debugger for SAM devices is now GDB. GDB does in some scenarios handle debugging of

optimized code better.
• Support to create a GCC Board project (Atmel board\User board) for ALL the installed versions of

ASF
• New ASF Board Wizard, to Add or Remove Board Project Template
• Improved loading time of New Example Project dialog, by loading only one ASF version by default
• IDR events now gets displayed in a separate pane in the output window
• LSS file syntax highlighting

1.5. Atmel Studio 6.1 Update 2
• Support for SAM D20 devices on the JTAGICE3
• Atmel Software Framework 3.11.0

1.6. Atmel Studio 6.1 Update 1.1
• Fix programming of boot section for XMEGA devices introduced in 6.1 update 1
• Fix SAM4LSP32 bare-bone project setup

1.7. Atmel Studio 6.1 Update 1
• Atmel Software Framework 3.9.1
• Extension Development Kit (XDK). Support for packaging an Embedded Application project into an

Atmel Gallery Extension.
• Support for SAM D20 and SAM4N devices
• ARM GCC Toolchain 4.7.3 with experimental newlib-nano and multilibs
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1.8. Atmel Studio 6.1
• Support for Embedded Debugger platform
• Support for Xplained Pro kits
• Atmel Software Framework 3.8.0
• AVR 8-bit Toolchain 3.4.2 (with upstream GCC 4.7.2)
• AVR 32-bit Toolchain 3.4.2 (with upstream GCC 4.4.7)
• ARM GCC Toolchain 4.7.3
• CMSIS 3.20
• Updated Visual Assist
• Command line utility for firmware upgrade
• Stimulus for simulator. Create a stimuli file to write register values while executing simulation.

1.9. Atmel Studio 6.0
• Support for Atmel ARM-based MCUs with Atmel SAM-ICE
• Atmel Software Framework 3.1.3
• AVR Toolchain 3.4.0
• ARM Toolchain 3.3.1
• Atmel Software Framework Explorer
• Support for QTouch Composer as extension
• Updated Visual Assist
• New extension gallery

1.10. AVR Studio 5.1
• New version of AVR Software Framework (ASF)
• Availability and installation of new ASF versions through extension manager, without having to

upgrade Studio 5
• Support for side by side versioning of ASF, with the ability to upgrade projects
• Syntax highlighting and better debugging support for C++ projects
• Support for importing AVR 32 Studio C++ projects
• New version of AVR Toolchain
• New command line utility (atprogram) with support for all Atmel AVR tools and devices
• Enhancements to programming dialog including support for ELF programming
• New version of Visual Assist with several enhancements and bugfixes

Atmel Atmel Studio 7.0 [RELEASE NOTE]
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2. Frequently Asked Questions
Frequently asked questions about Atmel Studio.

What is the Atmel USB
Driver?

The Atmel USB Driver is a cumulative installer that bundles the Jungo
USB driver for the AVR tools and the Segger USB Driver for SAM tools.

I get an error during
installation of the Atmel
USB Driver Package.

During installation of the Atmel USB Driver Package, you might get the
error 0x800b010a - A certificate chain could not be built to a trusted root
authority. This means that the certificate that signs the installer could not
be validated using the certificate authority built in to Windows.

The reason for not being able to validate the certificate is because the
certificate chain needs to be updated through Windows Update. Make
sure that you have received all updates, so that Windows is able to
validate the certificate.

If you are not able to update your computer due to the computer being
offline or restricted in some way, then the root certificate update can be
downloaded from http://support2.microsoft.com/kb/931125.

Will Atmel Studio work in
parallel with older versions
of Atmel Studio, AVR
Studio, and AVR32 Studio?

Yes, it will work side by side between major and minor versions. Side by
side installation with different build numbers are not possible. If you are
uninstalling AVR Studio 4.0 or AVR32 Studio be careful when you
manually delete folders or registry entries after uninstall, as there might
be other keys and folders deployed by Atmel Studio inside the Atmel
folder and registry paths. Note that drivers may be incompatible
between versions.

I have AVR Studio 4 in my
PC. When installing Atmel
Studio it updated the Jungo
USB driver. Will AVR Studio
4 still work?

Yes, it will work. If Jungo driver is already present and its version is
anything less than the new one, then the installer will update the Jungo
driver you already have. The newest Jungo USB driver (version 12)
breaks compatibility with older versions. See KB: Downgrading tools for
how to switch between Jungo versions.

Atmel Studio cannot find
any debuggers or
programmers when Norton
AntiVirus is running.

Atmel Studio might not show any connected tools if Norton AntiVirus is
running. To make it work make sure Norton AntiVirus allows
atprogram.exe to communicate with Atmel Studio by adding
atbackend.exe as an exception in the Norton AntiVirus allowed
programs. This is the same with any anti-virus program that by default
blocks ports.

Windows shows a message
box with the following
message when attempting
to run Atmel Studio
installer: "Windows cannot
access the specified device,
path or file. You may not
have the appropriate
permissions to access the
item. "

This might be caused by an anti-virus program blocking the installation
of the Atmel Studio. We have seen this with the Sophos antivirus
package. Temporarily disable the Sophos service running on the
machine (or any corresponding anti-virus service), and attempt
installation.
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Atmel Studio takes a very
long time to start, but runs
well in a VM environment.

The Visual Studio shell (and thus Atmel Studio) does a considerable
amount of processing during start-up. Parts of the operations are WPF
operations which benefits greatly by updated graphics libraries and
drivers. Installing the latest graphics driver may give a performance
boost both during normal operation and during start-up.

Verification and
programming often fails
with a serial port buffer
overrun error message
when using STK500.

This is a known issue. Due to DPC latency, serial communication can
have buffer overruns on the UART chipset. A workaround which works
for most systems is to use an USB to serial adapter.

When launching from a
guest account, the following
error is displayed when
starting Atmel Studio:
"Exception has been thrown
by the target of an
invocation".

Atmel Studio neither installs under guest account and nor runs under it.

Can install and run Atmel
Studio from within a Virtual
Machine.

Yes, with simulator there should be no issues. However with physical
devices like debuggers and programmers, the VM must offer support for
physical USB and Serial port connections.

How can I reduce the start-
up time of Atmel Studio?

• Make sure you have uninstalled unwanted extensions
• Disable Allow Add-in components to load:

2.1. Go to Tools, Options, Add-in/Macro Security.
2.2. Then uncheck the Allow Add-in components to load

option.
• Disable the start-up page:

3.1. Go to Tools, Options, Environment, Startup, At Startup.
3.2. Select the Show empty environment option.

How to improve studio
performance for any
supported version of
Windows?

• Make sure your system has the latest version of the Windows
Automation API

• Exclude the following directories and files from your antivirus
scanner:

– The Atmel Studio installation directory, and all files and
folders inside it

– %AppData%\Roaming\Atmel directory, and all files and
folders inside it

– %AppData%\Local\Atmel directory, and all files and folders
inside it

– Your project directories
• Visual Studio Shell requires a lot of swap space. Increase the

paging file. Also put the system to maximize performance. Both
options are found in the System, Properties, Performance,
Settings menu.
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Should I install the latest
Windows Automation API
3.0?

Yes, if your OS is any of the following:
• Windows Server 2008

How can I make sure my
system has the latest
Windows Automation API
3.0?

Your system has the latest Windows Automation API if you have
Windows 7 or Windows 8. Only Windows XP, Windows Vista,
Windows Server 2003, and Windows Server 2008 have the old version
of the API. Find the UIAutomationCore.dll file in your system (normally
found in the windows folder) and compare the version number of that
file. The version should be 7.X.X.X. for the new API. The latest API can
be found at http://support.microsoft.com/kb/971513.

My Project is large and it
takes a long time to open. Is
there any option to avoid
this delay?

Visual Assist X parses all the files when we opening the existing project.
You could disable this option:

1. Go to VAssistX, Visual Assist X Options, Performance.
2. Uncheck the Parse all files when opening the project.

I have the limited RAM size
in my system and I work
long hours in the same
instance of Atmel Studio.
After some time, Atmel
Studio becomes slow on my
system.

Press Ctrl+Shift+Alt+F12 twice to force Atmel Studio to garbage collect.

Does Atmel Studio perform
better on multi-core
processors than on single-
core systems?

Yes, Atmel Studio performs better on a multi-core system.

How can I make my projects
build faster?

You can enable parallel build Option from Tools, Options, Builder, GNU
Make, Make Parallel Execution Of Build. This option will enable the
parallel execution feature in the GNU make utility. This option may
cause the build log to be displayed unordered.

2.1. Compatibility with Legacy AVR Software and Third-party Products

2.1.1. How do I Import External ELF Files for Debugging?
Use the File → Open object file for debugging.

2.1.2. How do I Reuse My AVR Studio 4 Projects with the New Atmel Studio?
1. Click the menu File→Import AVR Studio 4 project.
2. An "Import AVR Studio 4 Project" dialog will appear.
3. Type in the name of your project or browse to the project location by clicking the Browse button of

the APFS File location Tab.
4. Name the new solution resulting from the conversion of your project in the Solution Folder Tab.
5. Click Next.
6. Atmel Studio will proceed with conversion. Depending on the complexity and specificity of your

project there might be some warnings and errors. They will be shown in the Summary window.
7. Click Finish to access your newly converted project.
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2.2. Atmel Studio Interface

2.2.1. How can I Start Debugging My Code? What is the Keyboard Shortcut for Debugging?
Unlike the AVR Studio 4 to build your project, without starting debugging, you should press F7.

If you need to rebuild your project after a change to the source files, press Ctrl Alt F7 .

To Start debugging - press F5.

To open the Debugging Interface without running directly, press the Debug→Start Debugging and
Break menu button, or press F11.

To start a line-by-line debugging press F10, to start an instruction by instruction debugging session -
press F11.

To run your project without debugging, press the Debug→Start Without Debugging menu button.

2.2.2. What is a Solution?
A solution is a structure for organizing projects in Atmel Studio. The solution maintains the state
information for projects in .sln (text-based, shared) and .suo (binary, user-specific solution options) files.

2.2.3. What is a Project
A project is a logic folder that contains references to all the source files contained in your project, all the
included libraries and all the built executables. Projects allow seamless reuse of code and easy
automation of the build process for complex applications.

2.2.4. How can I use an External Makefile for my Project?
The usage of external makefiles and other project options can be configured in the project properties.

Remember that an external makefile has to contain the rules needed by Atmel Studio to work.

2.2.5. When Watching a Variable, the Debugger says Optimized away
Most compilers today are what is known as an optimizing compiler. This means that the compiler will
employ a number of tricks to reduce the size of your program, or speed it up.
Note:  This behavior is usually controlled by the -On switches.

The cause of this error is usually trying to debug parts of code that does nothing. Trying to watch the
variable a in the following example may cause this behavior.
int main() {
   int a = 0;
   while (a < 42) {
       a += 2;
   }
}

The reason for a to be optimized away is obvious as the incrementation of a does not affect any other
part of our code. This example of a busy wait loop is a prime example of unexpected behavior if you are
unaware of this fact.

To fix this, either lower the optimization level used during compilation, or preferably declare a as
volatile. Other situations where a variable should be declared volatile is if some variable is shared
between the code and a ISR3.

For a thorough walk through of this issue, have a look at Cliff Lawsons excellent tutorial on this issue.

3 Interrupt Service Routine
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2.2.6. When Starting a Debug Session, I get an Error Stating that Debug Tool is not Set
The reason for this message is that there are no tool capable to debug that are selected for your project.
Go to the Tool project pane and change the to a supported tool.

If the tool you have selected does support debug, then check that the correct interface is chosen and that
the frequency is according to the specification. If the issue persist, try to lower the frequency to a
frequency where programming is stable, and then slowly increase the frequency as long as it keeps
stable.

2.3. Performance Issues

2.3.1. Atmel Studio takes a Very Long Time to Start on my PC, but runs well in a VM Environment. Is
there Something I can do with this?
Visual Studio shell (and thus Atmel Studio) uses WPF as a graphics library and does a lot of processing
in the GUI thread. WPF has support for hardware acceleration. Some graphics card drivers does not
utilize this well and spend time in kernel space even when no graphics update is required. Installing the
latest graphics driver may give a performance boost.

2.3.2. Verification and Programming often Fails with a Serial Port Buffer Overrun Error Message when
using STK500
This is a known issue. Interrupt DPC latency for serial communication may be disrupted by other drivers,
thus causing buffer overruns on the UART chipset. A workaround which works for most systems is to use
a USB to serial adapter.

2.3.3. I've connected my Tool through a USB Hub, and now I get Error Messages and Inconsistent
Results while Programming and Debugging
Tools and devices should be connected directly to an USB port on your debugging PC. If this is not an
option, you may reduce/eliminate problems by:

• Disconnect any other USB devices connected to the hub
• Switch ports on the USB hub
• Set the tool clock frequency low. E.g. Set JTAG Clock < 600kHz.
• If Use external reset is an option for your tool/device combination, enable this

Note:  The AVR Dragon should be connected through a powered USB hub. This because the power
supply on the Dragon can be too weak if the motherboard does not provided enough power. If the Dragon
times out or freezes, then the hub might be of to low quality.

2.4. Driver and USB Issues

2.4.1. How do I get my Tool to be Recognized by Atmel Studio?
This should happen automatically, but sometimes the Windows driver does not recognize the tool
correctly. To correct this, you have to check that the tool is listed under the Jungo item in the device
manager in Windows. If your tool is not listed, try to find it under Unknown devices. If it is located there,
try to reinstall the driver by double clicking the tool, click the Driver tab and choose Update Driver. Let
Windows search for the driver. The driver should be reinstalled and the tool should be displayed under
Jungo. Now, the tool should be usable from Atmel Studio.
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2.4.2. The Firmware upgrade Process fails or is Unstable on a Virtualized Machine
Most tools will perform a reset when asked to switch from normal operation mode to firmware upgrade
mode. This forces the tool to re-enumerate on the USB bus, and the virtualization software may not
reattach to it making your virtualized system with a disconnected tool.

Normal virtualization software supports the idea of USB filters where you set a collection of USB devices
you want to automatically attach to a given guest operating system. Check the manual for your
virtualization solution to see how this is done, or see the Firmware Upgrade fails on VirtualBox.

2.4.3. Debugging never Breaks under a Virtualized Machine
Some virtualization solutions have a limit on how many USB endpoints it supports. This may become an
issue if the number of endpoints is lower than the required number for the tool. Usually this causes
programming to work as expected but debug not to work as debug events are transmitted on a higher
endpoint number.

Check with your virtualization software how many endpoints are available, and on other endpoint specific
issues with your virtualization software regarding this.

2.4.4. No Tool is recognized by Atmel Studio, but the Driver seems to be Working
On some systems the Jungo driver is known not to activate properly. This can be seen as the WinDriver
unit under Jungo in the device manager in Windows is missing. To remedy this, try the following:

1. In your Device Manager, right click on your computer name (the very top item) and choose Add
Legacy Hardware.

2. Click next, and choose to install the hardware manually.
3. Choose the Show All Devices item on the top of the list, and click next.
4. Click the Have Disk button.
5. Navigate to the folder Atmel USB which is located under the install directory for Atmel Studio

(typical location is C:\Program Files (x86)\Atmel\Atmel USB.
6. Choose the usb32 or usb64 folder depending on the architecture you are running.
7. Inside there should be only one file named windrvr#.inf, where the hash is the revision number for

the driver. Double click this, click OK, and the WinDriver should appear in the list. If you get an error
message, you probably have chosen the wrong architecture.

8. Click Next until finished.
9. Verify that the WinDriver has appeared under Jungo.

The tools should be working straight away, but you may have to restart your machine if you are still
having problems.

2.4.5. Firmware Upgrade fails on VirtualBox
When doing a firmware upgrade on any tool, the tool needs to be reconnected in another mode than the
one used during regular operation. This causes the tool to be re-enumerated, and can cause the tool to
be disconnected from the VirtualBox instance and returned to the host operating system.

To make the tool connect automatically to the VirtualBox instance, you need to set up a couple of USB
filters. More information on USB filters can be found in the VirtualBox documentation.

Make two filters that are similar to the two shown in Figure 2-1 VirtualBox USB Filter.
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Figure 2-1. VirtualBox USB Filter

Note that the example in Figure 2-1 VirtualBox USB Filter is specific for the JTAGICE mkII. There are one
entry for the tool, here the JTAGICE mkII, and one for AVRBLDR, which is the firmware upgrade mode for
the tool. The name, serial, Vendor ID, and Product ID may be different for your tool, so change those
values accordingly.

Note:  This section contains specifics to VirtualBox. The same logic applies to other virtualization
software, but the steps may differ.

2.4.6. Common Jungo USB Errors
Jungo is the driver stack that is used for older programmers and debuggers, up to the JTAGICE3.

Common Jungo USB Error Codes
Table 2-1. Common Jungo USB Errors

Error Cause Resolution

Internal system error USB subsystem malfunctions Reinstall driver and check Driver and USB
Issues page

Conflict between read
and write operations

Directional error in data Disconnect and reconnect the tool
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Error Cause Resolution

Data mismatch Expected and received/sent data
error

Make sure that you use the latest driver for
your USB controller and the latest firmware
for your toolPacket size is zero Sent or received a zero packet

Insufficient resources Unable to set up send/receive
buffers due to memory limitation

Free more memory or try to restart your
machine

USB descriptor error

Error in control data on USB bus Try connection tool to another USB port

Wrong unique ID

Device not found

Wrong unique ID

Timeout expired

Error Cause Resolution

2.4.7. Issues with ARM Compatible Tools
In some rare instances all ARM compatible tools disappears from Atmel Studio. This has been tracked
down to different dll load strategies used in different versions of Windows.

To check that it is a dll load error, try to read out the chip information using atprogram. This can be done
by opening the Atmel Studio command prompt from the Tools menu inside Atmel Studio or from the start
menu. In the command prompt, enter the following command and check that it does not fail.
atprogram -t <tool> -i <interface> -d <device> info
In the snippet above, replace <tool> with the tool name, e.g. atmelice, samice, or edbg. Likewise,
replace interface with the used interface and the device with the full device name, e.g. atsam3s4c.

Invoking the above command should output information about the memory layout, the supply voltage for
the chip, and the fuse settings. If it fails it is likely a driver issue, which is covered by Driver and USB
Issues.

If atprogram is able to communicate with the device it means that the issue is most likely a wrong
version of JLinkArm.dll being loaded due to loader precedence. To check this, use the Procmon tool
to check what dll is being loaded.

Download the Procmon tool, open it, and configure the filter shown in Figure 2-2 Procmon Filter
Configuration. Then start Atmel Studio. A couple of seconds after Atmel Studio has started, one line
should become visible showing the path to where the dll is being loaded from. It should be loaded from
the atbackend folder inside the Atmel Studio installation directory.
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Figure 2-2. Procmon Filter Configuration

If the path of the dll is different it means that Atmel Studio has picked up the wrong dll, and this dll is
incompatible with the dll shipped with Atmel Studio. An example of this is shown in Figure 2-3 Procmon
Filter Configuration.

Figure 2-3. Procmon Filter Configuration

To solve the above issue, we recommend backing up the dll that is being loaded and then replacing it with
the JLinkARM.dll found in the atbackend directory inside the Atmel Studio installation directory. This
can be done given the assumption that the dll bundled with Atmel Studio is newer than the one that is
being loaded, and the dll is backwards compatible.

Note:  Remember to back up the offending JLinkARM.dll before replacing it, as it is not given that it
will be compatible with the program that deployed it.
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3. Installation
Installation instructions.

Supported Operating Systems
• Windows 7 Service Pack 1 or higher
• Windows Server 2008 R2 Service Pack 1 or higher
• Windows 8 / 8.1
• Windows Server 2012 and Windows Server 2012 R2
• Windows 10

Supported Architectures
• 32-bit (x86)
• 64-bit (x64)

Hardware Requirements
• Computer that has a 1.6GHz or faster processor
• RAM

– 1GB RAM for x86
– 2GB RAM for x64
– An additional 512MB RAM if running in a Virtual Machine

• 6GB of available hard disk space

Downloading and Installing
• Download the latest Atmel Studio installer
• Atmel Studio can be run side by side with older versions of Atmel Studio and AVR Studio®.

Uninstallation of previous versions is not required.
• Verify the hardware and software requirements from the "System Requirements" section
• Make sure your user have local administrator privileges
• Save all your work before starting. The installation might prompt you to restart, if required.
• Disconnect all Atmel USB/Serial hardware devices
• Double click the installer executable file and follow the installation wizard
• Once finished, the installer displays an option to Start Atmel Studio after completion. If you

choose to open, then note that Atmel Studio will launch with administrative privileges, since the
installer was either launched as administrator or with elevated privileges.
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4. Extensions
Short information about the Extension Manager and the extension ecosystem.

Extensions and updates to Atmel Studio are available through the Atmel Gallery. Access it through http://
gallery.atmel.com or use the extension manager in Atmel Studio under the Tools menu.

The set of extensions supporting a given Atmel Studio version may vary. Visit http://gallery.atmel.com to
see which extensions are available for a given version of Atmel Studio. Note that at the time of the
release of a new version of Atmel Studio not all extensions have been ported from the previous version.

Atmel Studio does not automatically reinstall extensions installed on previous versions of Atmel Studio.
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5. Features and Bugs

New Features

AVRSV-3139: A STK600 card stack error
must generate a popup message.

In case of error about STK600 routing card, there are no
popup message in Device Programming tool.

AVRSV-6118: NanoTrace not available
for simulator.

NanoTrace is now enabled for all devices when using the
simulator since the simulator is not dependant of any HW
for doing PC sampling.

AVRSV-7071: Need to index custom
option pages for search.

Be able to search in option pages.

AVRSV-7077: Show document text in
search tooltip.

Show document text in search tooltip

AVRSV-7411: Flash caching was not
enabled for SAMD devices.

Flash caching is not enabled for SAM D devices. This
causes a loss of performance during debugging.

AVRSV-7427: Calling atprogram with
serialnumber and without toolname
does not work.

Allow atprogram to get the tool type from the serial number
information.

AVRSV-7428: Add possiblity to print
only signature.

Add --signature to the info command in atprogram to only
print the device signature.

Notable Bugs Fixed

AVRSV-1436: SYNC issues with tools
after timeout failure.

If a command times out during execution on a tool, then
the next command can fail with a 'Command Error'. This is
due to desynchronization between the software and
hardware, and is fixed by power cycling the tool.

AVRSV-3572: Stepping on sei(); does not
set I flag.

Stepping on sei(); does not set I flag.

AVRSV-6515: Project creation is very
slow due to accessing version of tool
chain more often than required.

Project creation is very slow due to accessing version of
toolchain more often than required.

AVRSV-6668: Project using makefile at
relative path crashes many things in
studio.

Project using makefile at relative path lead to an error in
accessing the IO view.

AVRSV-6676: Launching a debug session
does nothing.

Starting a debug session fails with 'Failed to launch. Error
code 89710015'. This is caused by bad video card drivers.
Please update your drivers to the latest version available
from your manufacturer.

AVRSV-6811: atprogram verify command
using .bin file complains about missing
address space (prog).

When trying to run the atprogram verify command using
a .bin file you get the following error: [ERROR] An error
occurred executing a command (verify): Could not find
specified address space (prog)
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AVRSV-6823: Toolbar buttons not
displaying correctly after installation of
Atmel Studio (MS issue).

Toolbar buttons rendered incorrectly when running Studio
first time.

AVRSV-6873: Jungo drivers stop working
on some Windows 10 installations.

Jungo drivers stops working on some Windows 10
installations. This has been resolved in Atmel Studio
7.0.634 by using Jungo version 12 and links the following
tools to this driver: Dragon, ISPmkII, JTAGICEmkII,
STK600 and AVR ONE! If you plan to use these tools and
have a parallel installation of the latest Atmel Studio 7 and
earlier Studio installations or IAR EW please read the KB
article on how to change the binding back to a different
Jungo version in the Device Manager. http://
atmel.force.com/support/articles/en_US/FAQ/
Downgrading-tools-to-use-older-Jungo-driver

AVRSV-6983: Uninstalling extension
bricks Studio in some cases. Issue with
Clarius Extension Manager.

In some cases installing / uninstalling an extension leads
to Atmel Studio not starting. An error message "Cannot
find one or more components. Please reinstall the
application." appears.

AVRSV-6997: Disc Space Check option
hangs .

The installer might sometimes hang on the disk check. To
be able to proceed select "Back" one step and then "Next"
again.

AVRSV-6999: Incorrectly removing ":" for
C labels when enabling "Remove
whitespaces trailing..." option.

Incorrectly removing ":" for C labels when enabling
"Remove whitespaces trailing..." option

AVRSV-7008: Opening a 6.2 project in
Atmel studio 7.0 persists Debug
configuration settings for all the other
configurations.

When an Atmel Studio 6.2 project is opened in Atmel
Studio 7.0, the debug configuration settings gets persisted
for all the other configurations for that project.

AVRSV-7014: Start Debugging and Break
fails for 2nd attempt with simulator.

Some ATmega and ATtiny devices failed to start
debugging with the Simulator.

AVRSV-7018: Project Creation fails for
Culture specific user names.

Project creation fails on selecting device and SAM project
linking fails when user has unicode characters in the path.

AVRSV-7019: Help Viewer does not work
on 32 bit machines.

When trying to open Help Viewer in 32 bit machines the
following message is given: "The Help Viewer command
line includes an invalid catalog name AtmelStudio70.
Specify a valid name".

AVRSV-7021: Studio Crashes when
enabling Trace View in Some Projects.

Fixed a random studio crash while enabling MTB Trace /
Nano Trace

AVRSV-7033: Tools programming/read
add 0x0d bytes in binary.

Reading device memory in some cases read incorrectly
0x0D bytes.

AVRSV-7047: While opening 5.1 project
in 7.0, project not migrated to latest pack
infrastructure.

Issue importing Atmel Studio 5.1 projects into Atmel
Studio 7.0
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AVRSV-7084: During the upgrade, user
settings like recent projects, external
tools, parallel build are not persisted.

During upgrade of Atmel Studio, user settings like recent
projects, external tools, parallel build are not persisted.

AVRSV-7176: When opening a project,
the same file opens multiple times.

Opening a ASF project opens multiple instances of some
files.

AVRSV-7222: Start without debugging
uses a default clock (unconfigured) of 1
MHz.

Start without debugging ignores user settings and uses a
default clock (unconfigured) of 1 MHz.

AVRSV-7230: "Show all files" doesn't
show files unused in the project but
existing in the directory.

"Show all files" doesn't show all existing files in the
directory, it only shows files used in the project.

AVRSV-7267: Launching with many
breakpoints (6) causes flash-controller
fault on SAM4E.

Binding many breakpoints during launch can cause
memory corruption.

AVRSV-7305: Using the fuses and
lockbits page fails for ATmega DFU and
AVR XMEGA FLIP bootloaders.

Trying to open the Fuse or Lockbit page in the
programming dialog failed when using the ATmega DFU
and XMEGA Flip bootloaders.

AVRSV-7312: ATmega DFU fails to
launch.

Launching on a device using the ATmega DFU bootloader
caused an error due to the wrong erase command being
issued.

AVRSV-7337: GDB crashes intermittently
on SAMV71.

GDB crashes on some SAM devices due to a race
condition when programming flash and launching the
debug session.

AVRSV-7341: Drag-n-drop files into the
solution explorer should link, not copy.

Default behavior when files is dragged into the solution
explorer is to copy. This fix gives an option to change the
behavior to link the file when dragged into the solution
explorer, and adds the possibility to hold down the ALT
key when dragging the file to create a link.

AVRSV-7342: Can not move links in the
solution explorer.

Linked files can not be moved in the solution explorer.

AVRSV-7343: Linked files in the solution
explorer are sometimes absolute,
sometimes relative.

Fixes a bug where linked files added to a newly created
project is stored with an absolute path in the project
instead of relative path.

AVRSV-7346: Atmel Studio is deleting
linked files.

When moving linked files in the solution explorer,
sometimes the source file can be deleted. Normal file
operations are no longer done on linked files in the
solution explorer.

AVRSV-7376: Atmel-ICE slow
programming.

Atmel Studio was erroneously waiting too long for
completion of SAMD flash page erases, resulting in long
programming times.

AVRSV-7378: Chip Erase with EDBG fails
if erase pin is not connected.

Chip Erase fails on EDBG kits where the erase pin is not
connected.
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AVRSV-7379: Unhandled exception when
writing fuses or lockbits when Auto Read
is turned off.

Unhandled exception when writing fuses or lockbits when
Auto Read is turned off. This causes Atmel Studio to
crash.

AVRSV-7396: Exception in
MemoryPressureResolver.

Some machines shows an error regarding 'Exception in
MemoryPressureReliever'. This is caused by a change
the .NET framework, which was not handled correctly.

AVRSV-7400: Disable debugWire and
close hidden in easy-mode.

When in Standard mode, Disable debugWire and Close is
not visible in the Debug menu. To activate the fix, reset the
profile selection by going to 'Tools->Select Profile' and
click the 'Reset' button. This will reload the active profile to
the default one.

AVRSV-7408: Set startup project in
solution explorer hidden in easy-mode.

When using Atmel Studio in Standard mode, the Set
Startup Project menu is missing. To activate the fix, reset
the profile selection by going to 'Tools->Select Profile' and
click the 'Reset' button. This will reload the active profile to
the default one.

AVRSV-7415: Remove project from the
Recent project list on the Startpage does
not work.

Removing projects from the recent list on the start page
did not work.

AVRSV-7422: Breakpoint on reset vector
does not work.

When using the Start Debugging function (without break)
to launch a debug session, a breakpoint placed at the
reset vector was ignored during startup.

AVRSV-7426: atprogram info does not
print signature for Cortex-M0+.

Signature information is not printed from atprogram for
Cortex-M0+ devices.

AVRSV-7454: Import project template
fails.

'File->Import->Project template' fails with missing
'Ionic.zip' assembly.

AVRSV-7459: Project fails to build if it
has source file name with letters in
Capital case.

Projects containing files with upper case filenames can fail
to build. Saving files with upper case filenames converts
filename to lower case.

Known Issues

AVRSV-283:
webproperties.tlb file
missing.

A message saying "webproperties.tlb could not be located" can be
displayed on some systems. A workaround for this problem is to make
a copy of a file named "webproperties???.tlb" in "C:\Program Files
(x86)\Common Files\microsoft shared\MSEnv" (on the same location)
and rename it to "webproperties.tlb".

AVRSV-414: Handle Power
toggle and external reset for
all emulators and
architectures/families.

Power toggle and external reset is not handled gracefully in all
situations.

AVRSV-546: .NET Framework
install might not work if
there is limited network
connectivity.

The .NET Framework installer might not work properly if network
connectivity is limited. If connectivity is limited disconnect from the
network or disable all active network adapters before starting
installation of Atmel Studio.
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AVRSV-628: Scrolling
memory view does not work
properly.

Scrolling memory view does not work properly. It is not possible to use
the slider in the memory view to scroll it. Only the up and down arrows
works.

AVRSV-680: Breakpoint is
not updating in the
Disassembly and Code view.

Sometimes breakpoints that are set in the Source Editor are not
reflected correctly in the Disassembly Window while debugging.

AVRSV-831: .NET install fail
because Windows Imaging
Component WIC is not
installed.

Atmel Studio installation may fail on XP systems if the Microsoft
Windows Imaging Component (32-bit) is not installed. Install this
component, downloadable from Microsoft.

AVRSV-966: Installer crashes
when trying to install from
"runas" option.

Running the Atmel Studio installer using the "run as" option on
Windows XP may crash the installer.

AVRSV-1192: Internet
Explorer 6 does not show
user documentation
correctly.

Internet Explorer 6 will not render the navigation menu in the user
documentation correctly.

AVRSV-1254: The asf.h
header file is not included in
all examples.

The asf.h header file is not included in all examples. Workaround:
Include this file manually if you add additional drivers using the "Select
Drivers from AVR Software Framework" dialog.

AVRSV-1533: Microsoft
Visual Studio 2010 Shell -->
Error: Cannot publish
because a project failed to
build.

Visual Studio 2010 RC/Beta version has conflict with RTM version of
Microsoft Visual Studio 2010 Isolated Shell. The workaround is to
uninstall Microsoft Visual Studio 2010 isolated Shell that is installed
with Atmel Studio.

AVRSV-1557: Mapped
network drives do not
appear in Project Location
window.

Mapped network drives do not appear in the Project Location window
when creating a new project.

AVRSV-1603: shared register
access not possible?.

When debugging on ATmega16[A] or ATmega32[A] devices it is not
possible to read out the value of UBRRH using the debugger.

AVRSV-1675: Tool marked as
available even though OS
driver is not installed.

If a driver for a tool has not been installed (first time it's plugged in) and
the user plugs the tool into the PC when Atmel Studio is running then it
will be shown in the "Available Tools" view but not have access to the
tool as a OS driver for the tool does not exist. Any operation on the tool
initiated will fail. Restart Atmel Studio to access the tool.

AVRSV-1733: Single step
over SW reset on Xmega
does not work.

Stepping in the source view over a software reset may leave the target
running on ATxmega devices.

AVRSV-1758: Non-Latin
characters in project paths
are not supported.

Projects which include paths or files with non-Latin characters are not
supported.

AVRSV-1760: Issues with
AVR Studio 5 installed

Service Pack 1 of Visual Studio 2010 installed on a PC where Atmel
Studio 6 is installed, may initiate a need for reapplying the SP1
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alongside Visual Studio 2010
SP1.

installer. A dialog box will then appear during startup of Atmel Studio,
and detail the steps that must be taken.

AVRSV-1883: PORT registers
in IO view behaves
incorrectly.

The IO window does not fully support registers like e.g. DIRSET,
DIRTGL, and DIRCLR for the XMEGA family (used to manipulate a
corresponding DIR register). Toggling the value of bits in these
registers have undefined result on DIR.

AVRSV-1888: Detect m103c
compatibility fuse setting on
atmega128.

Debugging ATmega128 in ATmega103 compatibility mode is not
supported.

AVRSV-1895: VAssistX: Alt +
G does not open file <avr/
io.h>.

'Alt + G' does not open the file <avr/io.h>. This file is not parsed by
Visual Assist.

AVRSV-1901: Solution with
two projects does not work.

Creating two projects in the same solution which have different devices
is not supported. Create two different solutions instead.

AVRSV-2022: Conflicts with
Folding@Home.

Running Folding@home together with Atmel Studio may cause
unresponsive user interface. We recommend to disable the
Folding@home when running Atmel Studio.

AVRSV-2163: File/Folder
names with spaces are not
built property.

Files or folders with more than one consequent spaces are not
supported as part of AVRStudio 5 projects.

AVRSV-2558: HVPP for
ATtiny2313A does not work
on STK500.

HVPP for ATtiny2313A does not work on STK500.

AVRSV-2601: VS6
incompatibillity with AS5.

During installation of Atmel Studio, the Visual Studio 2010 Shell
installation will re-register the 'vsjitdebugger'. This might make Visual
Studio 2008 and Visual Studio 2005 unable to debug a crashed
application reported by Windows. Workaround: Run repair of Visual
Studio on top of the Atmel Studio installation. This should re-enable the
capability of Visual Studio to get a chance to handle crashed
applications.

AVRSV-2884: AVR Studio
cannot create a project from
template with a deep file
architecture.

Project creation may fail when file/folder name of the project or its sub-
items name exceeds 256 characters limit.

AVRSV-3296: Visual assist
inserts the c++ keywords,
functions in C project.

Autocompletion and snippets provided by Visual Assist can generate
invalid embedded C++, and it might also try to insert C++ in a C
project. This includes exceptions, classes and namespace
declarations.

AVRSV-3313: In Atmel Studio
6.1 compilation fails for ASF
Projects created with AVR
Studio 5.1.

If you encounter the error : variable 'xxxx' must be const in order to be
put into read-only section by means of '_attribute_((progmem))', then
this description applies. The problem is due to the incompatibility of the
ASF source code with the AVR GCC compiler. The GCC 4.6 Release
document (http://gcc.gnu.org/gcc-4.6/changes.html) mentions that the
error is expected and to use the ASF projects created in 5.1 (i.e ASF
2.9.0) we have to use avr gcc toolchain verison 3.3.1 and for later ASF
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versions use 3.4.0. Alternatively you could manually add the const
qualifier to the variable(s) that are reported, when compiling ASF 2.9.0
projects with AVR GCC toolchain 3.4.0 or later.

AVRSV-3672: Can't use
network path in "New
Example Project from ASF"-
dialog.

ASF projects cannot be created in UNC paths. To create the ASF
project, map the UNC path to a network drive.

AVRSV-3993: JTAGICE3
event endpoint is not
registered on virtual
machines.

On virtual machines like VirtualBox, the event endpoint may not work
properly and no events will be propagated from the tool to Atmel
Studio. This mainly impacts debugging.

AVRSV-4005: Setting
lockbits for SAM4LC4C have
no effect.

Setting flash region lockbits when using SEGGER may have no effect,
as the SEGGER tool may unlock the flash region before it writes to it at
a later stage.

AVRSV-4050: User signature
on RFR parts can only be
accessed by JTAG or parallel
programming.

User signature on RFR parts can only be accessed by JTAG or parallel
programming.

AVRSV-4079: Unable to
launch using an ELF file
containing LOCKBITS.

Launching debug with an ELF file containing non-0xFF lockbits may
fail. Lockbits should not be set for debugging.

AVRSV-4337: After Installing
AtmelStudio 6.1, the old
projects does not build in
earlier versions of
AtmelStudio.

Build abruptly fails in Atmel studio without proper error message and
the error window shows no error. Tail of the Build Output: Task
"RunCompilerTask" ========== Build: 0 succeeded or up-to-date, 1
failed, 0 skipped ========== Reason: Project file was upgraded from
6.0 to 6.1. Steps to Restore back the project to working condition:
Scenario 1: (With Backup) Check whether there is a back up project in
the projectfolder with the name ProjectName_6_0 (For Example the
backup project is GccApplication1_6_0.cproj if the actual project name
is GccApplication1.cproj) * Project with the name GccApplication1.cproj
is the upgraded project to confirm edit the project file in editor you
should be able to see <ProjectVersion>6.1</ProjectVersion>. * Open
the project GccApplication1_6_0.cproj in Atmel Studio 6.0. It should
prompt you to save the solution file. Save and build it should work fine.
Scenario 2: (Without Backup) If the backup project is not found in the
project folder chances are that you would have upgraded the project
from 6.0 to 6.1 without opting for the backup. * Edit the project file
modify <ProjectVersion> tag and set the version to 6.0 and also modify
the <ToolchainName> tag by removing .C or .CPP from the tag ( For
example com.Atmel.AVRGCC32.C must be renamed as
com.Atmel.AVRGCC32) build the project now.

AVRSV-4380: No error or
warning is displayed when
number of characters in
command line arguments
exceeds microsoft
limitation. .

When building a project in Atmel Studio, and if you get an error like the
one as follows <some file>.o: No such file or directory during the linking
stage, then it could be because of the number of characters in the
command line. Windows expects that the command line be less than
8192 characters. To workaround the issue, reduce the name of the
folder so that the command line becomes shorter.
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AVRSV-4440: Breaking
changes in SAM header files
going from 6.0 to 6.1.

The SAM header files have been updated and due to this there are
breaking changes when upgrading from 6.0 to 6.1. Bare bone SAM
projects created with Atmel Studio 6.0 can get compilation errors due to
changes in defines. You can continue to use the old headers by
keeping Atmel Studio 6.0 and 6.1 installed in parallel and use the
toolchain from 6.0. ASF projects are not affected.

AVRSV-4501: Path of
toolchain's native libraries
are wrong.

Toolchain libraries "Full Path" property will display the base path of the
current toolchain.

AVRSV-4521: Expanding /
collapsing node does not
refresh the files in solution
explorer.

If a library is removed, the Library list in the solution explorer may not
update. Double click the "Libraries" node to refresh the status of
Libraries presence.

AVRSV-4576: Modifying
EEPROM contents in the
memory view causes data
corruption on XMEGA E5.

Modifying EEPROM data values in the memory view during debugging
of XMEGAE5 devices causes the EEPROM data to be corrupted.

AVRSV-4659: SAM4L and
UC3-kilogram programming
fails with core voltage at
>1.9V.

Programming SAM4L and some UC3 devices may fail when core
voltage is raised above 1.9 V.

AVRSV-4693: Struct type is
not displayed correctly for
composite types in a COFF
project.

For COFF object file debugging, elements in the "type" field of a watch
on a composite data type might contain the object/variable name
instead of the type name.

AVRSV-4753: SAM D20
Xplained Pro shows
incorrect chip ID.

In the information window for Xplained Pro kits, the revision is not the
actual chip revision, but the revision coded into the Xplained Pro itself.
Use the Programming Dialog to read the correct revision from the
device.

AVRSV-4899: In External
Interrupt controller example,
stepping through NMI
debugging is not working.

Debugging inside the NMI handler on UC3 does not work. This is
probably due to the fact that the NMI interrupt has a higher interrupt
priority than breakpoints.

AVRSV-5029: Not able to set
CLKPR bits while debugging
in Xplained Pro Mega256rfr2.

Writing bitfields that needs to be written in a timed sequence from the
I/O view will not work. This is the case for CLKPR, IVSEL and WDTEN,
to mention some bitfields.

AVRSV-5050: Studio should
warn if BOOTPROT is set
when programming target.

If the BOOTPROT fuse is set in the device, flash memory may not get
programmed correctly and no error will be displayed. If debugging, the
program will not get uploaded, but debug will proceed with the wrong
image.

AVRSV-5324: SAM D20 - IO
View - OUTSET / OUTCLR
improperly updated.

Modifying SAMD20 port registers like OUTSET, OUTCLR and OUTTGL
will not have the expected result unless the full register value is taken
into consideration. The mentioned registers reflects the current value of
OUT when read by the user application and Atmel Studio. Clicking a
single bit in one of these registers in the IO View will write back the full
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register with only the clicked bit toggled from its existing value, causing
a set, clear or toggle action also on other set bits in that register. These
considerations can be avoided by directly setting and clearing bits in
the OUT (or corresponding) register.

AVRSV-5339: Live Watch is
not updated when single
stepping on UC3.

Variables in Live Watch are not updated when single stepping on UC3
devices.

AVRSV-5378: Debugger on
SAM4L-EK is clearing the
interrupt flags.

SAM devices: Interrupt flags that are cleared by reading a register, can
unexpectedly be cleared by the debugger if the register is monitored in
the IO view or the Memory view in Atmel Studio. An example is the
RXRDY flag for USART0 in SAM4LC4C, which might be cleared if the
debugger breaks and reads the RHR register in order to display its
value.

AVRSV-5450: It is not
possible to get trace from
multicore device.

During trace activation, Atmel Studio can silently fail to enable trace on
multi-core devices where the TRACESWO pin is shared by the cores
through a mux that does not switch automatically to the active core. To
be able to get trace on these devices, the mux for the TRACESWO
signal needs to be set correctly by the users application.

AVRSV-5527: Live Watch :
Value of complex expression
not computed.

The Live Watch feature in Atmel Studio does not work well with
expressions as the variable. Since the watch in this case is on a
memory address, the Live Watch implicitly adds a ampersand (&)
before the variable being watched to extract the address of the
variable. This means that expressions will be evaluated to the wrong
value.

AVRSV-5635: Unable to
debug when assigning fuse
bits through .elf.

Care should be taken when debugging a project with embedded fuse
information. The debugging session might misbehave if the fuses
overwrites settings that Atmel Studio assumes to have control over.

AVRSV-5711: Cannot debug
SAM D code with Atmel
Studio if .text section is
relocated.

Relocating the .text segment may cause the debugger to fail in certain
conditions. This results in 'Start debugging and break' to stop at a high
address in the disassembly view. To make the debugger break the
application entry, tick the 'Override VTOR' option in the project
properties, and ensure that the text box contains the address of the
interrupt vector. This is usually 'exception_table' or '&exception_table',
depending on the startup code in the project. The difference between
these is that '&exception_table' is a struct, while 'exception_table' is a
function pointer array.

AVRSV-5792: Installing 6.2
public after 6.2 ServicePack1
corrupts the Service pack
installation.

Installation of Atmel Studio 6.2.1153 after Atmel Studio 6.2 Service
Pack 1 corrupts the installation of Atmel Studio 6.2 Service Pack. The
installations cannot co-exist so always uninstall Atmel Studio 6.2
Service Pack 1 before installing Atmel Studio 6.2.1153.

AVRSV-5837: Backend times
out if ''USE GDB'' is selected
for UC3 devices.

Trying to enable GDB for AVR32 projects will probably fail in even the
simplest debugging, such as Halt, Step, and Go. It is not recommended
to ignore the warning shown when this option is enabled for a project.

AVRSV-5854: Installation of
USB Driver package fails on
clean Win 7 (64-bit) machine.

The Atmel USB Driver Package may fail during installation with error
'0x800b010a - A certificate chain could not be built to a trusted root
authority'. The reason for this is that the built in certificate in Windows is
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out of date and needs to be updated through Windows Update. If you
are unable to perform a update, then the update can be manually
downloaded from KB931125 from Microsoft.

AVRSV-5952: Firmware
upgrade fails from
jtagice3v2.15 to jtagice3+.

Upgrading JTAGICE3 from major version 1 or 2 to major version 3 can
fail. The first firmware upgrade attempt will only put the JTAGICE3 into
boot mode, and not do an actual upgrade. Running a second firmware
upgrade without toggling power to the tool should work. The simplest
workaround is to use atfw found in '<Atmel Studio installation folder>
\atbackend\'. From a command prompt (inside Atmel Studio, go to
Tools|Command Prompt) run"atfw.exe -t jtagice3 -a "<Atmel Studio
installation folder>\tools\jtagice3\jtagice3_fw.zip", which would normally
be atfw -t jtagice3 -a "C:\Program Files (x86)\Atmel\Atmel Studio
6.2\tools\jtagice3\jtagice3_fw.zip". The first attempt will fail, but when
running the command again without toggling power on the JTAGICE3 it
should pass. Note that as soon as the JTAGICE3 has been upgraded
to a firmware with major version 3 or higher, firmware upgrade should
work on first attempt also from Atmel Studio 6.2 SP1.

AVRSV-5987: Cannot chip
erase SAM4L in backup
mode on SAMICE.

Atmel Studio would not be able to erase a SAM4L part if the part was
put into a sleep mode immediately after startup. Note that a POR may
be required after programming to be able to establish contact.

AVRSV-6364: ARP entry
added into the control panel
even if one of the packages
get installed by the
bootstrapper.

Atmel Studio 7.0 entry will be visible in Add Remove programs even if
the installation is unsuccessful or partial. Please remove the entry and
try installing again.

AVRSV-6372: Installing
Atmel Studio Extensions
does not seem to detect
Atmel Studio 7.0.

If VSIX (Atmel Studio extensions) are installed manually, there might be
conflicts between Atmel Studio and Visual Studio due to issues in the
Microsoft Visual Studio Version Selector (VSLauncher.exe) executable.
To fix this, change the file association for VSIX files from
VSLauncher.exe to C:\Program Files (x86)\Microsoft Visual Studio
12.0\Common7\IDE\VSIXInstaller.exe (D:\Program Files\Microsoft
Visual Studio 12.0\Common7\IDE\VSIXInstaller.exe on 32-bit systems).
Changing the file association is done by Shift-Right Click the VSIX,
choose 'Open With...' and browse to the VSIXInstaller.exe in the path
shown above.

AVRSV-6405: Device
disconnected error comes
after updating firmware. But
allows to debug program.

Tools may fail to re-enumerate after a firmware upgrade, causing the
tool to be listed as disconnected. If this happens, reconnect the tool
and it should re-enumerate and become connected again.

AVRSV-6427: Abort of
Uninstall sequence leaves
the system in intermediate
state.

If the system goes into an intermediate state after abort of uninstall
sequence (forceful exit of installation process) the state could be
recovered by repairing Atmel Studio 7.0 from control panel.

AVRSV-6664: Atmel Studio
crashes when I search in the
options dialog.

Atmel Studio may crash when searching in the Options page. The
issue lies in the Visual Studio shell, and is fixed in version 2013.4 and
newer. To apply the fix, download Visual Studio 2014 Update 4 or
newer from https://www.visualstudio.com/news/vs2013-update4-rtm-vs
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or from https://www.microsoft.com/en-us/download/details.aspx?
id=44921 .

AVRSV-6677: Issues with
graphics driver can cause
rendering glitches.

Atmel Studio tries to offload as much of the graphics rendering of the
user interfaces as possible to the graphics card to free up CPU
resources. If the graphics driver does not support hardware rendering,
Atmel Studio will fall back to using software rendering. However, in
some cases, this fallback does not work for some reasons, causing
rendering glitches in the user interface. The best way to solve this issue
is to make sure that the latest graphics driver is installed from your
graphics card vendor.

AVRSV-6848: Upgrading
JTAGICE3v1 and v2 to v3
works, but studio needs to
be restarted.

Atmel Studio fails to connect to JTAGICE3 after upgrading from
firmware version 1 or version 2. To be able to connect, Atmel Studio
needs to be restarted.

AVRSV-7003: Current
measurements does not
work when running
debugging or programming
at low baud.

Running current measurements in Data Visualizer while programming
or debugging at low interface frequencies/baud rates might result in
Data Visualizer disconnecting from the Power Debugger. The lower
limit of the interface speed varies depending on target type, flash size
and interface type but is typically in the range 100-300kHz.

AVRSV-7154: Studio upgrade
breaks functionality for other
users on the same computer.

If a USER is using an Atmel Studio installed by another user ADMIN
(USER!=ADMIN), and Atmel Studio is updated by ADMIN, Atmel Studio
will still be using the old extensions that were copied to the %appdata%
folders. To correct, the USER must delete the %appdata%/Atmel
(roaming and local) folders so that they are reinitialized by the new
version of Atmel Studio on the next start.

AVRSV-7163: Installing AVR8
Toolchain 7.0: 'An error
occured: The specified
account already exists'.

Run 'Microsoft Fix' it and uninstall 'AVR8 Toolchain 7.0'. After this, run
the Atmel Studio installer and choose repair.

AVRSV-7309: Multiple
Windows security dialog
boxes during driver install
on Windows 7.

Some Windows 7 machines can experience multiple security dialog
boxes during the driver installation. Clicking the Trust this publisher
checkbox does not work. This is related to KB2921916, this hotfix can
be downloaded from https://support.microsoft.com/en-us/kb/2921916.

AVRSV-7450: Debugging
does not work if chip is not
erased (Skip programming)
on launch.

Launch may fail if Skip Programming is selected in the project settings.

Other Issues Fixed
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6. Device Support
Device support in Atmel Studio is done using the concept of device family packs. The format is inspired
by the Keil CMSIS-Pack specification, and packs containing ARM devices are fully compatible with the
Keil CMSIS-Pack specification. For AVR and AVR32 packs, some Atmel specific extensions to the format
have been implemented.

CMSIS-Pack describes a couple of use cases, and the packs used in Atmel Studio to provide device
support is part of the Device Family Pack (DFP) use case. This pack contains all needed files to support
compilation, programming and debugging of a device. More information about the CMSIS-Pack
specification, visit http://www.keil.com/pack/doc/CMSIS/Pack/html/index.html.

Atmel Studio includes a tool to manage packs, called Pack Manager. It is available in the Tools menu in
Atmel Studio and gives the ability to install, remove, and list information related to packs.

6.1. Packs
Abbreviations:

D Debugging is supported on the listed interfaces

P Programming is supported on the listed interfaces

dW debugWIRE

aW aWire
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6.2. Device Notes
Information about mature devices.

The following mature devices are not recommended for new designs:

• ATtiny11
• ATtiny12
• ATtiny15
• ATtiny22
• AT90S1200
• AT90S2313
• AT90S2323
• AT90S2343
• AT90S4433
• AT90S8515
• AT90S8535
• ATmega323
• ATmega161
• ATmega163
• ATmega103
• ATmega165
• ATmega169
• ATmega64HVE
• ATmega32U6
• AT90PWM2
• AT90PWM3
• AT90SCR100
• AT86RF401

See http://www.atmel.comfor replacements.
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7. Revision History
Revision Changes

D February release of Atmel Studio

C Never released

B Initial version of Atmel Studio 7.0

A Never released
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